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Legal Notices

Warranty
The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an 
additional warranty. HP shall not be liable for technical or editorial errors or omissions contained 
herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend
Confidential computer software. Valid license from HP required for possession, use or copying. 
Consistent with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software 
Documentation, and Technical Data for Commercial Items are licensed to the U.S. Government 
under vendor's standard commercial license.

Copyright Notice
© Copyright 2013 Hewlett-Packard Development Company, L.P.

Trademark Notices
This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This 
product includes software written by Tim Hudson (tjh@cryptsoft.com). Smack software copyright 
© Jive Software, 1998-2004. SVG Viewer, Mozilla JavaScript-C (SpiderMonkey), and Rhino 
software Copyright © 1998-2004 The Mozilla Organization. This product includes software 
developed by the OpenSSL Project for use in the OpenSSL toolkit. (http:// www.openssl.org). 
OpenSSL software copyright 1998-2005 The OpenSSL Project. All rights reserved. This project 
includes software developed by the MX4J project (http://mx4j.sourceforge.net). MX4J software 
copyright © 2001-2004 MX4J Team. All rights reserved. JFreeChart software © 2000-2004, Object 
Refinery Limited. All rights reserved. JDOM software copyright © 2000 Brett McLaughlin, Jason 
Hunter. All rights reserved. LDAP, OpenLDAP, and the Netscape Directory SDK Copyright © 
1995-2004 Sun Microsystems, Inc. Japanese Morphological Analyzer © 2004 Basis Technology 
Corp. The Sentry Spelling-Checker Engine Copyright © 2000 Wintertree Software Inc. Spell 
Checker copyright © 1995-2004 Wintertree Software Inc. CoolMenu software copyright © 2001 
Thomas Brattli. All rights reserved. Coroutine Software for Java owned by Neva Object 
Technology, Inc. and is protected by US and international copyright law. Crystal Reports Pro and 
Crystal RTE software © 2001 Crystal Decisions, Inc., All rights reserved. Eclipse software © 
Copyright 2000, 2004 IBM Corporation and others. All rights reserved. Copyright 2001-2004 Kiran 
Kaja and Robert A. van Engelen, Genivia Inc. All rights reserved. Xtree copyright 2004 Emil A. 
Eklund. This product includes software developed by the Indiana University Extreme! Lab (<http:// 
www.extreme.indiana.edu/>). Portions copyright © Daniel G. Hyans, 1998. cbg.editor Eclipse 
plugin copyright © 2002, Chris Grindstaff. Part of the software embedded in this product is gSOAP 
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software. Portions created by gSOAP are copyright © 2001-2004 Robert A. van Engelen, Genivia 
Inc. All Rights Reserved. Copyright © 1991-2005 Unicode, Inc. All rights reserved. Distributed 
under the Terms of Use in http:// www.unicode.org/ copyright.html.

Adobe™ is a trademark of Adobe Systems Incorporated.

Java™ is a registered trademark of Oracle and/or its affiliates.

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.

Oracle® is a registered US trademark of Oracle Corporation, Redwood City, California.

UNIX® is a registered trademark of The Open Group.

For a complete list of open source and third party acknowledgements, visit the HP Software 
Support Online web site and search for the product manual called HP Service Manager Open 
Source and Third Party License Agreements.
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Documentation Updates
The title page of this document contains the following identifying information:

 l Software Version number, which indicates the software version.

 l Document Release Date, which changes each time the document is updated.

 l Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using the most recent edition of a document, go 
to:

      http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign in. To register for an HP Passport 
ID, go to:

      http://h20229.www2.hp.com/passport-registration.html

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support 
service. Contact your HP sales representative for details.
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Support
Visit the HP Software Support Online web site at:

      http://www.hp.com/go/hpsoftwaresupport

This web site provides contact information and details about the products, services, and support 
that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and 
efficient way to access interactive technical support tools needed to manage your business. As a 
valued support customer, you can benefit by using the support web site to:

 l Search for knowledge documents of interest

 l Submit and track support cases and enhancement requests

 l Download software patches

 l Manage support contracts

 l Look up HP support contacts

 l Review information about available services

 l Enter into discussions with other software customers

 l Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also 
require a support contract. To register for an HP Passport ID, go to:

      http://h20229.www2.hp.com/passport-registration.html

To find more information about access levels, go to: 

      http://h20230.www2.hp.com/new_access_levels.jsp
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What's New in This Release
This section describes important changes in this release.

Server's KM Search Engine Schema File Updated 
In SM9.31p3, the server's KM search engine schema file (/RUN/km/styles/schemastub.xml) has 
been updated to solve the issue that an advanced search in the Problem Library does not return 
expected results. See "QCCR1E94887".

The line in bold in the following section  has been changed:

From:

<fieldType name="text" class="solr.TextField" positionIncrementGap="100">

    <analyzer>

        <tokenizer class="solr.WhitespaceTokenizerFactory"/>

        <filter class="solr.WordDelimiterFilterFactory" 

          generateWordParts="1" generateNumberParts="1" catenateWords="1" 

          catenateNumbers="1" catenateAll="0" splitOnCaseChange="1"/>

        <filter class="solr.LowerCaseFilterFactory"/>

    </analyzer>

</fieldType>

To (by inserting preserveOriginal="1" in the line):

<fieldType name="text" class="solr.TextField" positionIncrementGap="100">

    <analyzer>

       <tokenizer class="solr.WhitespaceTokenizerFactory"/>

       <filter class="solr.WordDelimiterFilterFactory" 

        generateWordParts="1" generateNumberParts="1" catenateWords="1" 

        catenateNumbers="1" catenateAll="0" 

        splitOnCaseChange="1" preserveOriginal="1"/>

       <filter class="solr.LowerCaseFilterFactory"/>

    </analyzer>

</fieldType>

Note: These lines exist only in the SM9.31 or a later version of the schemastub.xml file.

If you customized your old schemastub.xml file, installing the server patch will overwrite your 
customizations. If you do not want to update your KM search engine, simply copy your old 
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schemastub.xml file back; otherwise restore your customizations and reindex your 
knowledgebases as follows after your server upgrade:

 1. Open the new schemastub.xml file in a text editor.

 2. In the new file, restore the customizations you made in your old schemastub.xml file.

 3. Perform a full reindexing on all of your knowledgebases.

Data Policy Definitions Can Be Added on Join Files
Starting with this release, users can add data policy definitions on join files. See server fix 
"QCCR1E52767 ".

Note: This server fix requires QCCR1E52767_SM931P3_SM930.unl, available from the server patch's 
platform_unloads directory. See application fix "QCCR1E52767".

Note: The impact of this server change is that some old data policy definitions may break the join 
files. The solution is to correct the data policy definitions.

For example, joinsvcDisplay is joined by svcDisplay and  svcCatalog. In the out-of-the-box 
SM9.30 GA applications, the name filed in svcCatalog is defined as read-only in Data Policy (which 
has been fixed in the SM9.31 or later applications). Before this server change, because the data 
policy did not work on the join file, the name field in svcCatalog could still be edited. Now, since the 
data policy definition works on the join file, the user cannot edit the name field in svcCatalog when 
creating a new  joinsvcDisplay record. This is incorrect.

To work around this issue, remove the read-only definition for the name filed:

 1. Open the datadict for file svcCatalog.

 2. Locate the "name" field in "Field Settings".

 3. Remove the "true" value in the "Read Only" column and save.

 4. Log off and log back in.

Behavior Changed When Handling Web Service 
Request User Passwords

In this release, Service Manager has changed its behavior when handling a web service request 
with an expired user password. When receiving a web service request sent with an user whose 
password has expired, SM denies the request and returns an HTTP Unauthorized 401 Error.  The 
response message is: 

<HTML><BODY>5: Your password has expired. You must change it before you can log 
on.</BODY></HTML>.

Note: This behavior change  requires the QCCR1E96802_SM931P3_SM930.unl file, which is 
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available from the server patch's platform_unloads directory.

Certifications
The following database version has been certified on the SM server of this release:

 l DB2 10.1
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Fixed Defects
This release fixes the following defects.

Server
CR Problem Solution

QCCR1E31622 Asynchronous eventin records generated by 
Connect-It have a First Expiration: entry set to 
the tod() time that is GMT, instead of the tod() 
for the local time zone. For example, an eventin 
generated at 1600 Pacific Daylight Savings 
Time shows an entry of 2300 on an SM system 
with the System Information Record set to 
Pacific Daylight Time time zone.

This is a time zone issue. The time now has been 
converted to the right time zone.

QCCR1E52767 Users cannot add data policy definitions on 
joined tables.      

Now users can add data policy definitions on joined 
tables.

For more information about this fix, see "Data Policy 
Definitions Can Be Added on Join Files" on page 9.

QCCR1E84054 When you try to modify an ESS format (for 
example, ess.SD.update.browse) to enable a 
popup subform, the subform displays the 
expected field values, but also displays extra 
objects as shown in the following:  

"<Unsuppor <Unsuppor"

This was a design issue and is now fixed. Note that after 
applying the server patch for this defect, you need to 
restart the web tier to see the effect because the web tier 
will cache the response of "get format" messages.
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CR Problem Solution

QCCR1E88441 The parameter threadstacksize is obsolete, 
but still displays when users run the sm -
helpthreadingcommand.

This parameter is no longer returned when users run the 
sm -helpthreading command.

QCCR1E89489 SCauto loses connection to the database due to 
unexpected Oracle errors.  When this issue 
occurs, alerts are delayed in SM from OMU, and 
sometimes no incidents are opened in SM when 
they are received from OMU through SCauto.

When encountering the Oracle errors, SM will reconnect 
to the database and allocate a new handle to ensure that 
the SCauto application can access the database.

QCCR1E90472 You receive license-warning messages in the 
sm.log file that indicate the local and remote 
host licenses do not match. In addition, new 
login sessions are rejected because the amount 
of the licenses is retrieved incorrectly when the 
JGROUP network issue occurs.

The SM server now uses the following steps to ensure 
that licenses are retrieved correctly: 

 1. Use grouplicenseip to retrieve the license.

 2. If step 1 fails, use an empty IP to retrieve the 
license. 

 3. Sync the license with the cluster.

CCR1E91369 Inboxes cause signal 11 errors, which lead to 
high memory usage.

Inboxes no longer cause signal 11 errors and hence high 
memory usage does not occur.

QCCR1E92994 A view that includes joined fields does not 
refresh as expected after making changes to a 
single record in the record set. 

Refreshing a cross-table view will try to retrieve data 
when the old data does not match the query condition.

QCCR1E93163 Notifications generated with SCEmail using the 
HTML solution pack contain unwanted 
attachments ATT00001.c and ATT00002.htm.

Notifications are now delivered in HTML format without 
any attachments.
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CR Problem Solution

QCCR1E93240 The Service Manager LockHandler thread fails 
with the following message:  

JRTE E LockHandler: LockHandlerThread 
TRCLIENT_LOCKHANDLER Thread get an 
exception

The LockHandler thread no longer fails with the 
message.

QCCR1E93501 The SM server crashes during a stress test of 
web services.

By using a smaller length of target and source in the 
memcpy function to avoid memory overlap, now the SM 
server no longer crashes.

QCCR1E93933 Background processes terminate with a LOCK 
error, and a system restart is required.

Background processes will wait for the lock until 
successful.

QCCR1E93913 When you request an item that has many User 
Selection options (between 80 and 90), the 
following error message is received:

"Unexpected Exception: Runtime error or 
exception incurred in server. Please contact 
your Administrator", and you can find exception 
and core dump messages in sm.log.

This issue was caused by a buffer overflow, which is 
now fixed.

QCCR1E94107 A servlet, usually a servlet for Webservice 
requests, crashes multiple times a day.

The servlet does not crash when a session expires.
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CR Problem Solution

QCCR1E94426 The Service Manager server always keeps 
active transactions running on a SQL Server 
database, and this blocks some database 
operations such as changing the database 
owner.

Note: After a server startup and before any user login, 
you can find an active transaction from the 
SQLSERVER Management Studio's context menu item 
"Reports > Standard Reports > All Transactions". It was 
reported that there were other open transactions related 
to schedulers, however executing the "DBCC 
OPENTRAN" SQL command found that none of them 
were real open transactions (including the one found by 
the "report all" utility).   

Now, a "COMMIT" statement is executed at the end of a 
system startup. Active transactions are no longer 
observed by using the SQLSERVER Management 
Studio's "Reports > Standard Reports > All 
Transactions" utility.

QCCR1E94700 Low memory encountered in CIT servlet in SM 
Application.

Fixed the memory leak issue during reading RCString.

QCCR1E94707 The load balancer process issues the following 
message in the log:

JRTE I Balancer Couldn't find any 
available nodes. / by zero

This issue was caused by a logic related code problem in 
common.jar, which now has been fixed.

QCCR1E94887 An advanced search in the Problem Library 
always returns no records if using Affected CI 
as the query condition.

This issue was caused by an improperly used search 
engine index token in the schemastub.xml file, which 
has been fixed. See "Server's KM Search Engine 
Schema File Updated " on page 8.

An advanced search in the Problem Library now returns 
expected results.

QCCR1E94945 SCAutoListener servlet is not responding in 5 
minutes after startup.

The hang issue does not happen anymore as it was 
solved by adjusting the communication code.
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CR Problem Solution

QCCR1E95258 The JavaScript isDocumentElement() method 
returns "true" regardless of whether the current 
element is a document element or not.

The change which caused this issue has been reverted 
in a safe way.

QCCR1E95269 The user session terminates during a Mass 
Update or Mass Close. 

The issue is caused by improper memory allocation. 

Now the user session no longer terminates during a 
Mass Update or Mass Close. 

QCCR1E96802 Security issue, no details available. Security issue, no details available.

 

Web Client
CR Problem Solution

QCCR1E52658 When logged on to the web client, the strings 
that are longer than the width of a Combo Box 
are cut off and only partial content is displayed. 
You cannot drag the dropdown list to a larger 
size to see the whole long strings.

The issue is fixed by making the Combo Box resizable 
so that you can drag the dropdown list to a larger size to 
see long strings.

Limitations of the resizable Combo Box:

 l The resized dropdown list does not persist if your 
session terminates.

 l If the widget location is near the right side of the form, 
you cannot drag the dropdown list beyond the edge of 
browser. In this case, long strings cannot be 
displayed completely.
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CR Problem Solution

QCCR1E90671 Process Designer does not have a feature to 
apply a single RuleSet globally to a Workflow.

Now, with the next release of Process Designer Content 
Pack applied, the "Workflow Based Rule Sets", 
"Workflow Based Actions", and "Workflow Backend 
Transition" features will allow you to apply a single 
RuleSet at the workflow level.

QCCR1E90877 If you design a form to contain two check boxes 
or other widgets that have Read-Only conditions 
referring to each other, when you open this form 
in the Web client, an “Indefinite Loop..."  
message box displays.

Now if there are loop DVD conditions for widgets, the 
“Indefinite Loop..." message shows in the browser 
console, instead of in a popup message box.

QCCR1E91378 You receive the "Expression can't be edited 
because data is missing or corrupt" error when 
the value of RuleSet Condition Expression 
contains an ampersand (&).

Now, it works fine when the value of RuleSet Condition 
Expression contains an ampersand (&).

QCCR1E91635 When you use a small or low resolution screen, 
the Task Planner window does not appear in an 
appropriate size in the list-detail view. When this 
occurs, you cannot resize the window to view 
the task graphic in the task planner.

This issue is resolved by redesigning the window size 
and removing the resizable separator bar between the 
graph section and task property section.

QCCR1E91869 When you have more than two attachments 
attached to a change record and set a low 
screen resolution such as 1280x800, you have 
to scroll the horizontal scroll bar completely to 
the right to find the vertical scroll bar, and then 
you have to scroll the vertical scroll bar down to 
find the last attachment.

Now, the horizontal scroll bar is removed, and the 
vertical scroll bar is displayed only when the available 
display area is not enough for the list of attachments.

QCCR1E92011 Some groups display an empty label when the 
Notebook widget is in group rendering style.

Labels for all groups now display correctly when the 
Notebook widget is in group rendering style.

HP Service Manager (9.31)Page 16 of 47

Patch 3 Release Notes
Fixed Defects



CR Problem Solution

QCCR1E92010 Unexpected blank space display between two 
groups when the Notebook widget is in group 
rendering style.

Unexpected blank space no longer displays between two 
groups when the Notebook widget is in group rendering 
style.

QCCR1E92009 Unexpected widgets display between two 
groups when the Notebook widget is in group 
rendering style.

Unexpected widgets no longer display between two 
groups when the Notebook widget is in group rendering 
style.

QCCR1E92311 Inbox filter checkboxes have vertical scrollbars. 
When you use the scrollbar, the text on the right 
side does not scroll together and then you have 
disarrangement.

The Inbox filter checkboxes will not have vertical 
scrollbars, except when needed.

QCCR1E92348 The Condition Editor form is not displayed in the 
visible area of the screen.  Instead, the user has 
to move the scroll bar to the top of the area to 
see the Condition Editor form.

Now, the Condition Editor is displayed in the visible area.

QCCR1E92566 When searching for records in each module of 
Service Manager in the Web client, the first 
record in the QBE list is not only highlighted but 
also checked.

When searching for records in each module of Service 
Manager in the Web client, the first record in the QBE list 
is only highlighted.

QCCR1E92614 When you run a script in a form that has a list 
builder element, all variables 
(local/thread/global) are set to null when the 
display option is triggered.

When you run a script in a form that has a list builder 
element, all variables retain the correct value when the 
display option is triggered.
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CR Problem Solution

QCCR1E92635 Microsoft Office 2010 Excel files attached to a 
Knowledge Management document present a 
user with a Microsoft login when attempting to 
open the file in an OOB system.

When you click the link of an attached Microsoft Excel 
file, no login is required to open or save the file.

For external type of knowledge articles, only image and 
pdf formats are allowed to be displayed within the 
browser if supported, while all other types of documents 
will be force downloaded.

QCCR1E92709 The ToDo Queue and View disappear in the SM 
9.31 Web tier.

The ToDo Queue and View are no longer overlapped by 
the recordlist in the web tier.

QCCR1E92745 Service Manager web tier 9.31 patch 1 does not 
handle the 'Smart Context Indicator' queries 
correctly.

Now proper data is shown for 'Smart Context Indicator' 
queries.

QCCR1E92672 Users receive a 404 error when trying to open 
attachments from Incidents in the web client.

Users do not receive a 404 error when trying to open 
attachments from Incidents in the web client.

QCCR1E93417 The Condition Editor does not contain 
CurrentRecordAuth in the Workflow Editor.

With the next release of Process Designer Content Pack 
applied, the Condition Editor will provide the 
CurrentRecordAuth feature in the Workflow Editor.

QCCR1E93623 When a Phase change occurs, any transition 
between Phase 1 and Phase 2 is shown as a 
past transition.

With the next release of Process Designer Content Pack 
applied, a new field is added in the WorkflowHistory 
table to record which manual transition is called.

QCCR1E93779 The "Catalog Information" section displays in 
the Web Client even when the "user option" is 
empty.

The "Catalog Information" section no longer displays in 
the Web Client when the "user option" is empty.

QCCR1E94072 The Condition Editor cannot be configured to 
display CurrentRecord's field list for a system-
type field.

The Condition Editor can now be configured to display 
CurrentRecord's field list for a system-type field.  To do 
so, use Condition Editor Setting under the Process 
Designer menu from the next release of Process 
Designer Content Pack.
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CR Problem Solution

QCCR1E94358 The "Catalog Information" section is NOT 
displayed in the Web client when the user option 
is defined for a support item.

Now the "Catalog Information" section is displayed 
correctly in the Web client when the user option is 
defined for a support item.

QCCR1E95452 If no image file is specified for a service item, 
the Service Catalog list displays a broken image 
(red cross) next to the item name.

If no image file is specified for a service item, a red cross 
is no longer displayed next to the item name.

QCCR1E95919 In Internet Explorer (IE), the text is not properly 
aligned with the radio buttons in the "Related to" 
section of the Escalation Details form in the 
incident escalation wizard. The text "Existing 
Incident"/"Existing Known Error"/"New 
Incident" appear to be slightly above the line of 
the radio button, and too close to the radio 
buttons themselves.

The text is now aligned properly with the radio buttons 
and extra space has been inserted between them.

Windows Client
CR Problem Solution

QCCR1E92957 In the Windows client, a dropdown/comfill 
widget is not read-only when the form is read-
only. 

In the Windows client, a dropdown/comfill widget is now 
read-only when the form is read-only.
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Application
CR Problem Solution

QCCR1E52767 Users cannot add data policy definitions on 
joined tables. 

Now users can add data policy definitions on joined 
tables.

Note: This application fix is provided through  
QCCR1E52767_SM931P3_SM930.unl, available from the 
platform_unloads directory.

Documentation
 

CR Problem Solution

QCCR1E96750 The SM9.31p2 Release Notes document incorrectly includes 
parameter maxmemorypersession, which has not been 
implemented in 931p2. See  QCCR1E72835.

This parameter has been removed from the SM9.31p2 
Release Notes shipped with the SM9.31p3 release. 

Note: The updated document will also be republished 
soon on the HP Software Manuals Site: 
http://h20230.www2.hp.com/selfsolve/manuals
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Known Problems, Limitations, and Workarounds
This software release has the following known issues and limitations.

Global ID Problem Workaround

QCCR1E63663 The Service Manager (SM) client loses 
connectivity during JavaScript 
execution of the file.list RAD 
application.

No workaround available.

Created a knowledge article (KM1166532), which states that Service Manager 
does not currently support calls from JavaScript on RAD applications that use 
the rio/fdisp panels.
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Global ID Problem Workaround

QCCR1E57385 When Service Manager is running on 
Unix, the legacy listener may log 
intermittent signal 11 upon CIT initial 
connectivity test if exec-shield is not 
set properly.

Use one of the following solutions to solve this issue on Unix.

Solution 1:

Connect Connect-It to the Web Services connector instead of the Legacy 
Listener connector.

Solution 2:

Before connecting Connect-It to the Legacy Listener connector, do the 
following:

 1. Add  usethreading:0 in the sc.ini file, which is located in <Service Manager 
server installation path>\LegacyIntegration\RUN.

Note: For 64-bit RedHat Linux servers only, you can alternatively run the 
following shell commands as root:

# sysctl -w kernel.exec-shield=0

# sysctl -w kernel.randomize_va_space=0

 2. Start the legacy listener.

QCCR1E69449 The user encountered a signal 11 while 
updating an incident: RTE E Caught 
XML API exception scxmlapi(40).

This is because another user was 
updating the probsummary dbdict 
record at the same time.

When modifying a dbdict record, ensure that there are no other users updating 
records or inserting records in the same file. For example, when updating the 
probsummary dbdict, make sure that there are no other users updating existing 
incidents or opening new incidents. 

HP Service Manager (9.31)Page 22 of 47

Patch 3 Release Notes
Known Problems, Limitations, and Workarounds



Global ID Problem Workaround

QCCR1E67491 When the collation of the db instance 
is Chinese_PRC_BIN, Web service 
clients fail to connect to Service 
Manager (SM). Only ASCII operator 
names are supported, so only ASCII 
operator names can be used. 

Note: This issue only exists in Web service integrations. Therefore, the SM 
clients do not have this problem.

When SM is handling an incoming SOAP request, the authorization string is 
decoded by BASE64Decoder. SM uses the decoded string value to construct a 
UTF-8 string that is used in the RTE. However, the authorization string is in the 
header and SM does not know the charset or encoding of the underling string 
value, which is BASE64 encoded. 

Therefore, if the underlying string value is not UTF-8, this problem will occur. In 
SM, when fetching an operator record from the database, no matter what 
collation the database uses, the operator record finally will get a UTF-8 operator 
value. However, even if users put the same value in the authorization header, 
the operator name may differ because of the charset/encoding issue. Because 
of this, the operator will fail to log on.  

This is a limitation of SM. Do not use non-ASCII characters in operator names. 
Created a knowledge article (KM1442479) to document this limitation. 

QCCR1E75182 HTML email truncates the body of the 
message and sends the HTML code 
without translating it.

When the content of an HTML email template exceeds 8192 bytes in size, the 
content will be truncated and displayed as HTML code.   

Make sure your HTML email templates do not exceed this size limit.

QCCR1E89890 Grouped Views are not correctly 
updated after logging a new Incident.  

When you log a new incident, to keep consistency with actual incidents, the 
group number is not updated. 

You need to click the "Refresh" button to update grouped Views.

QCCR1E72835 Add the ability to limit the memory 
consumed by individual threads in SM 
as specified by an Administrator.

The requested change is not implemented to avoid performance degrade.

No workaround is currently available.
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Global ID Problem Workaround

QCCR1E77563 Signal 11 error is received when calling 
the toXMLString() routine of the Users 
object. 

No workaround is currently available.

QCCR1E77657 When using Mobility on a BlackBerry, 
users are taken to a back screen after 
entering comments for an Approval 
and then clicking the Back button. 
However, users should be returned to 
the Change queue.

No workaround is currently available.

QCCR1E88222 An unload file that is exported from an 
Oracle to an SQL Server database 
fails to import when the unload file 
already contains a RECORD_KEY 
field and the length of first unique key 
exceeds the db limitation.

This request is caused by the product running in an unsupported configuration. 
Change to a documented and supported configuration. If the problem still exists 
in a supported environment, contact HP Support.

To work around this issue, do not use "RECORD_KEY" as a SQL Name for a 
field in dbdict.  This field name is reserved by SM.  To do this, follow these steps:

 1. Enter dbdict in the SM command line box.

 2. Enter "esdquestions" in to the search field, and then click the Search 
button.

 3. Select the "record.key" field, and then change the SQL Name from 
"RECORD_KEY" to anything else.

QCCR1E74808 After clicking the Cancel button in the 
Condition Editor from the Workflow 
Editor, the current tab sometimes 
becomes a blank screen and the tab 
cannot be closed.

No workaround is currently available.
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Global ID Problem Workaround

QCCR1E99940 Customers on Solaris 9 cannot 
upgrade to SM9.31p2 or a later patch 
because JRE7 does not support 
Solaris 9 and Service Manager starts 
with a JRE validation that does not 
allow a JRE version below JRE7 
up15.

To continue to use JRE 1.6 on Solaris 9, modify the following three lines in the 
validjava.sh file located in the SM server's  RUN/ folder.

From: 

JAVA_UPDATE_VERSION_SUPPORTED=15

To: 

JAVA_UPDATE_VERSION_SUPPORTED= 20

From: 

if [ "${JAVA_VERSION}" = "1.7" ]; then

To: 

if [ "${JAVA_VERSION}" = "1.6 " ]; then

From: 

echo "Install or setup Java 7 correctly and then run 
./setupLinks.sh to re-create the symbolic links."

To:

echo "Install or setup Java 6   correctly and then run 
./setupLinks.sh to re-create the symbolic links."
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Documentation Errata
The following documentation item is incorrect. 

Location:

SM9.31p2 Release Notes: the New Parameters and RAD Functions section

Error:

Parameter maxmemorypersession, which has not been implemented in SM9.31p2, is incorrectly included in the SM9.31p2 Release Notes. 

This error exists in the SM9.31p2 Release Notes shipped with the SM9.31p2 release, as well as the release notes currently published on the 
HP Software Manuals Site: http://h20230.www2.hp.com/selfsolve/manuals

Correction:

Remove the parameter from the release notes and republish the document on the HP Software Manuals Site. 

Note: The version shipped with SM9.31p3 has already been corrected.
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Backup and Backout Instructions
If you want to restore your Service Manager system to its original state after installing this patch, 
follow these guidelines.

Server
To backout your server changes, make a backup before installing the patch and then roll back.

If you have also loaded platform unload files required for your server changes, you must also roll 
back the application changes made by the unload files. See "Applications" on the next page.

Backup
Before applying the server patch, make a backup of the server installation folder. For example, 
C:\Program Files\HP\Service Manager 9.31\Server.

Note: If you have a horizontally scaled system, be sure to back up the server installation folder 
for each server instance.

Backout
After installing the patch, do the following to backout:

 1. Stop the Service Manager server.

 2. Remove the existing server installation folder.

 3. Copy the backup folder back.

Note: Make sure that the embedded Tomcat is also replaced with the backup, because 
the version of the embedded Tomcat may have dependency on a specific server version.

Note: If you have a horizontally scaled system, make sure that every server instance is 
replaced with its  backup.

 4. Restart the Service Manager server.

Web Tier
Backup

Before deploying the new web tier, make a backup of the following items:

 l web.xml file

 l application-context.xml
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 l splash screen

 l style sheets

 l any other customizations you made, including your webtier-9.31.war (webtier-ear-9.31.ear) file.

Backout
To roll back to the old web tier:

 1. Delete or uninstall the existing web tier.

 2. Clear the cache of your web application server (for example, Tomcat).

 3. Redeploy the old web tier.

 4. Restore your old customizations.

Windows Client
To roll back to your old Windows client, you need to do backup before installing the new Windows 
client and then reinstall the previous Windows client. 

Backup

 1. Make a backup of your Windows client home folder, for example, 
C:\Users\<username>\ServiceManager. Your connections and personalized settings are 
stored in this folder.

 2. Make a backup of your certificate configuration files if any (Window > Preferences > HP 
Service Manager > Security). For example, your CA certificates file and client keystore file. 

Backout

 1. Uninstall the new Windows client.

 2. Reinstall the previous Windows client.

 3. Restore your old Windows connections and configurations.

Applications
Backup

Tip: If your application version is 7.11 ap3, 9.21 ap3, 9.30 ap3, 9.31 or later, you are 
recommended to use Unload Manager to make a backup of the files to be modified by an 
unload file, because Unload Manager can create a backup of your old data during the 
installation of the unload; if your application version is other than any of these, Unload Manager 
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is not available and you can use Database Manager instead. 

To use Unload Manager to make a backup:

 1. Go to System Administration > Ongoing Maintenance > Unload Manager.

 2. Double-click Apply Unload. A wizard opens.

 3. Select the unload file you want to apply, also specify a backup file, and then click Next. Details 
of the unload file appear.

 4. Double-click a conflicting object in the table to open the merge tool:

 a. Merge the object, and then select the Reconciled check box.

 b. Click Save to go back to the wizard.

 5. Click Next after all the conflicting objects are reconciled.

 6. Click Yes on the confirmation window to apply the unload.

 7. Click Finish. 

Now, the unload has been applied and at the same time your old data backed up.

To use Database Manager to make a backup:

 1. Go to Database Manager, select Import/Load from More or the More Actions menu, and 
browse to the unload file.

 2. Click List Contents on the menu bar, to view a list of files that have been updated in this 
unload.

See the following figure for an example.

HP Service Manager (9.31) Page 29 of 47

Patch 3 Release Notes
Backup and Backout Instructions



This figure shows the contents of an unload file that contains changes to the following files:

File Record

Process     svc.add.cart

application money.format

Note: The scmessage records listed under each RAD application are 
messages used in this RAD application; no backup is needed for them.

ScriptLibrary svcCartHelper

datadict activity

dbdict activity

Note: The “activity” file with no records actually represents the dbdict 
record of the activity file.

scmessage The record whose message class is “fc” and message number is 1000. 

 3. Go to Database Manager, in the Table field enter a file name you got in step 2, and click the 
Search button.

 4. If the format selection page shows, select the proper format by double-clicking it (for example, 
select the device format for the device file), and then search for the file record.

 5. Click More (or the More Actions menu) > Export/Unload after the file record displays.
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Note: If Export/Unload is not available, check the Administration Mode check box in 
Database Manager and try again.

 6. In the pop-up window, specify your backup upload file path/name, and click Unload Appl. 

Caution: Make sure that Append to file is selected.

 7. Repeat steps 3 through 6 to back up the rest of the files you got in step 2.

Backout

Tip: You can use Unload Manager (recommended) or Database Manager (if Unload Manager is 
not available in your application version) to roll back to your old data, as described in the 
following.

To roll back to your old data using Unload Manager:

 1. Go to  System Administration > Ongoing Maintenance > Unload Manager.

 2. Double-click Apply Unload. A wizard opens.

 3. Select the unload file generated in the backup process, specify a backup file, and then click 
Next. Details of the unload file display.

 4. Double-click a conflicting object in the table to open the merge tool:
 a. Merge the object, and then select the Reconciled check box.

 b. Click Save to return to the wizard.

 5. Click Next after all the conflicting objects are reconciled.

 6. Click Yes on the confirmation window to apply the backup unload.

 7. Click Finish.

To roll back to your old data using Database Manager:

 1. Go to Database Manager, click More > Import/Load.

 2. Browse to the backup unload file you created.

 3. Click Load FG.
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Installation Notes
This section provides instructions on installing each component in this patch release.

Before you proceed, HP recommends that you consult the latest Service Manager 9.31 Support 
Matrix at:

http://support.openview.hp.com/selfsolve/document/KM00208838

For more information, see "Service Manager Support Matrix" on page 47.

Digital Signature Notice
HP signs Windows executable files with a digital signature. Since January 2012, this process has 
been updated to use a new VeriSign root certificate. On a Windows system that does not have the 
new VeriSign root or intermediate certificate installed, when the user right-clicks the file and then 
goes to Properties > Digital Signatures > Details, a verification error will display: “The certificate 
in this signature cannot be verified.”

To resolve this issue, either enable Windows Update or download and install the G5 Root certificate 
as documented at: https://knowledge.verisign.com/support/ssl-certificates-
support/index?page=content&actp=CROSSLINK&id=SO19140
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Web Tier Installation
The web tier update consists of a compressed file, sm9.31.3009-P3_Web_Tier.zip, which contains 
the installation files (both the .war and .ear files) for installing the SM9.31p3 web tier. Installing the 
new web tier will upgrade your web client to this patch level.

The installation steps are the same as installing the SM9.30 web tier. The specific installation 
process depends on your particular web application server. For detailed steps, see the Service 
Manager 9.30 Interactive Installation Guide, which is available from the HP Software Manuals Site: 

http://support.openview.hp.com/selfsolve/document/KM1195794

For New Customers
You only need to install the new web tier using the .war or .ear file from the sm9.31.3009-P3_Web_
Tier.zip file in this release. For installation instructions, see the Service Manager 9.30 Interactive 
Installation Guide.

For Existing Customers
To upgrade your web tier to this patch level, you need to back up and uninstall your old web tier and 
then install the new web tier.  The upgrade does not automatically save your web tier 
customizations. To keep your changes, you must back up your customized files and restore your 
customizations in the new deployment.

Note on Tomcat 7.0: If you plan to deploy the web tier on Tomcat 7.0 using the Tomcat Manager, 
be sure to set the max-file-size and max-request-size parameters (default: 52428800) in the 
<Tomcat 7.0_Home>webapps\manager\WEB-INF\web.xml to an appropriate value greater than the 
web tier .war file size; otherwise the deployment request will be rejected because the web tier .war 
file exceeds the default maximum values. This restriction does not exist in Tomcat 6.0.

To install the new web tier:

 1. Make necessary backups. For details, see "Backup and Backout Instructions" on page 27.

 2. Delete or uninstall the existing web tier .war (or the .ear) file.

 3. Clear the cache of your web application server (for example, Tomcat).

 4. Deploy the new webtier-9.31.war (or the .ear) file following the instructions in the Service 
Manager 9.30 Interactive Installation Guide.

Note: It is best practice to deploy with a unique context root. For example: /webtier-9.31.3009

 5. Use a diff utility to compare the new web tier’s web.xml file against your backed-up version to 
ensure that any new parameters are properly merged into the files used in your final 
deployment. Do this for application-context.xml as well as any other files you may have 
customized (such as style sheets and splash screens).
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 6. Make any new customizations necessary for your deployment. 

 7. Restart the web application server.

Note: Before accessing the new web tier, HP recommends that all users empty their 
browser cache.

Windows Client Installation
The Windows client update consists of a compressed file, sm9.31.3009-P3_Windows_Client.zip, 
which contains the executable installation files of the new Windows client. Installing the new 
Windows client will upgrade your Windows client to this patch level.

The installation steps are the same as installing the SM9.30 Windows client. See the Service 
Manager 9.30 Interactive Installation Guide, which is available from the HP Software Manuals Site: 

http://support.openview.hp.com/selfsolve/document/KM1195794

For New Customers
You only need to install the new Windows client. by following the steps in the Service Manager 9.30 
Interactive Installation Guide.

For Existing Customers
You need to back up and uninstall the old Windows client, and then install the new Windows client. 

To install the new Windows client:

 1. Stop the Service Manager Windows client.

 2. Make necessary backups. For details, see "Backup and Backout Instructions" on page 27.

 3. Uninstall the Service Manager Windows client. (Your connection and personalized settings are 
retained.)

 4. Run setup.exe from this Windows client patch to install the new client by following the 
instructions in the Service Manager 9.30 Interactive Installation Guide.

 5. Check the version in Help > About Service Manager Client.

The client should be Release: 9.31.3009.

Server Update Installation
The server update for your operating system (OS) consists of a compressed file, sm9.31.3009-P3_
<OS>.zip (or .tar), which contains updated files of the Service Manager server. These files add to 
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or replace the files in the [SM Server Root]\([SM Server Root]/)RUN, irlang, 
legacyintegration, and platform_unloads directories.

Note: If using an Oracle RDBMS, be aware that Oracle Call Interface (OCI) 11.2.0.3 is 
required for SM9.30p5, SM9.31 and later. See the latest Service Manager 9.31 Support Matrix 
at:

http://support.openview.hp.com/selfsolve/document/KM00208838

Upgrade Paths
This server patch must be applied on top of one of the following versions/patch levels of the 
SM server:

 l SM9.30 GA

 l SM9.30 Patch/Hotfix

 l SM9.31 

 l SM 9.31 Patch/Hotfix

The following server upgrade paths are recommended:

 l New customers: Install the SM9.30 GA server, and then directly apply the latest 9.31 server 
patch;

 l Existing SC6.2, SM7.11 and 9.21 customers:  Uninstall the old server, install the SM9.30 GA 
server, and then apply the latest 9.31 server patch;

 l Existing SM9.30 or 9.31 customers: Apply the latest 9.31 server patch.

For installation instructions of the SM9.30 GA server, see the Service Manager 9.30 Interactive 
Installation Guide, which is available from the HP Software Manuals Site: 
http://support.openview.hp.com/selfsolve/document/KM1195794

For installation instructions of the server patch, see "Server Patch Installation Steps" below.

Server Patch Installation Steps

Caution:  

 l The server patch will upgrade your embedded Tomcat to version 6.0.36, and therefore 
requires additional steps.

 l Starting with SM9.31p2, the SM server requires JRE 1.7. For Windows and Linux, the 
embedded JRE has already upgraded to version 1.7; for other Unix-based platforms, you 
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need to manually perform this JRE upgrade.

The JRE upgrade will cause external web service calls over SSL to fail if the remote 
endpoint does not support Server Name Indication (SNI), which is by default activated in 
JRE 1.7. Once Service Manager is upgraded to use JRE 1.7, it starts to use SNI 
extensions during the SSL handshake. If the remote endpoint does not support SNI, the 
web service call will fail with an error message. To solve this issue, do either of the 
following:

 n Activate SNI at the remote end point (recommended)

 n If the remote endpoint does not support SNI extensions, and SNI cannot be activated, 
add the following JVMOption<n> parameter either to the sm.ini file, or to the start 
command of the servlet(s) in the sm.cfg file:

JVMOption2:-Djsse.enableSNIExtension=false

Note: If you have a horizontally scaled system, you must upgrade all of your server instances.

 1. Stop all Service Manager clients.

 2. Stop the Service Manager server.

 3. Make a backup of the Server installation directory. See also "Backup and Backout 
Instructions" on page 27.

 4. Delete the RUN/tomcat directory. Tomcat in this directory will be upgraded to version 6.0.36 
when you extract the server files later.

 5. Delete the RUN/lib directory.

 6. For Windows and Linux platforms, delete the RUN/jre directory.

Note: This step is required only when you are upgrading from a server version earlier than 
9.31p2. This is to avoid conflicts between the old 1.6-based JRE and new 1.7-based JRE.

 7. Extract the compressed files for your operating system into the main Service Manager 
directory on the server. The default path is: C:\Program Files\HP\Service Manager 
9.30\Server.

 8. For UNIX servers, set the file permissions for all Service Manager files to 755.

 9. For UNIX servers, manually upgrade to JRE1.7 if you have not already done so.
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 a. Install either JDK1.7 or JRE1.7 for your specific platform.

Solaris JRE1.7 (update 15 or greater)

HP-UX JRE1.7 (JRE_7.0.04 or greater)

AIX JRE1.7 (SR4 or greater)

 b. Set your JAVA_HOME environment variable to point to JDK1.7 (if you have JDK1.7 
installed) or JRE1.7 (if you have only JRE1.7 installed).

 c. Execute \RUN\removeLinks.sh to remove the old symbolic links and then execute 
\RUN\setupLinks.sh to create new symbolic links.

 d. Run the following command to check that the JRE version is 1.7: 

RUN\jre\bin\java –version

 10. If you have made any customizations/changes to the original RUN/tomcat folder, restore them 
in the new RUN/tomcat folder.

 11. Your old schemastub.xml file (in the <SM_Server_Home>\RUN\km\styles\ directory) has been 
updated to a newer version. Either keep your old file or update to the new version by following 
the instructions in  "Server's KM Search Engine Schema File Updated " on page 8.

 12. Make sure the server is stopped, and run the sm -unlockdatabase command.

Note: The purpose of this step is to prevent stale license information from being kept in 
the system. In a scaling implementation, you can run this command from any one of your 
servers.

Caution: This step is required the first time you upgrade to 9.30p4 or later; it is also 
required whenever you change the server’s IP address after your upgrade to 9.30p4 or 
later.

 13. Restart the Service Manager server.

 14. Restart the Service Manager clients.

 15. Check the version in Help > About Service Manager Server. The server should be Release: 
9.31.3009.
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Application Unload Installation
If a platform fix (in most cases, a server fix) also requires an applications change to resolve the relevant issue, an unload file is provided. 
Unload files introduced in earlier patches are also included in this cumulative release. If you have not already applied them for a previous 
patch, you should also apply the unload files that are intended for your applications version. For more details about these applications 
updates, see the Release Notes for those patches.

This patch release includes the unload files that come with the server update. When you extract sm9.31.3009-P3_<OS>.zip (or .tar), it will 
add the files to the following directory:

[SM Server Root]\platform_unloads ([SM Server Root]/platform_unloads)

Note: Unload files should be installed in their patch order. That is, those introduced in patch 1 should be applied first, then those 
introduced in patch 2, and so on. However, unload files introduced in the same patch can be installed in a random order, unless otherwise 
specified.

Unload File Naming Convention
The unload files use the following naming convention: <CR_ID>_SMxxxPxx_SMxxx.unl, where:

 l <CR_ID>: The identification number of the applications defect that the unload file fixes. For example, QCCR1E12345. Note that this is 
always the number of the parent CR of a CR family (if any).

 l SMxxxPxx: The minimum Service Manager patch level that requires the unload file. For example, SM921P2, which means the unload file 
comes with the server updates in Service Manager 9.21 patch 2 and should be used for patch 2 or higher.

Note: Sometimes this portion contains an additional hot fix number, for example, SM711P16HF8. This example means the unload file is 
intended for Service Manager 7.11 patch 16 Hot Fix 8 or higher.

 l SMxxx: The Service Manager applications version that requires the unload file. For example, SM711, which means the unload file is 
intended only for Service Manager applications version 7.11.
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Note: If the applications version suffix is omitted, the unload file is then intended for all applications versions compatible with the server 
version, unless otherwise specified. For example, QCCR1Exxxx_SM930P4.unl is normally intended for applications versions 7.11, 9.20, 
and 9.30 (which are compatible with Service Manager server 9.30), unless otherwise specified in the unload file description. For 
information on the applicable applications versions for each unload file included in the current patch, see Unload Files Included in the 
Current Patch.

Unload Files Included in the Current Patch
The following are unload files included in the current patch release.

Unload file
Introduced in  
9.3x patch

Used for 
apps version
(s) Description

QCCR1E96802_
SM931P3.unl

9.31p3 7.11, 9.21, 
9.30 and 9.31

Changes the behavior when handling web service request user 
passwords. See "Behavior Changed When Handling Web Service 
Request User Passwords" on page 9.

Associated server fix: QCCR1E96802

QCCR1E52767_
SM931P3_SM930.unl

9.31p3 9.30 Fixes the issue that users cannot add data policy definitions on joined 
tables. 

Note: You do not need to load this unload if you are running on SM9.31, 
9.21, or 7.11 applications.

Associated server fix: QCCR1E52767

QCCR1E76724_
SM931P2_SM930.unl

9.31p2 9.30 and 9.31 Fixes the issue that after deleting the unique key of cm3r, a signal 11 
happened while doing an IR regeneration.

Associated server fix: QCCR1E76724

QCCR1E76227_
SM930P6_SM930.unl

9.31 9.30 Contains the code changes to support localization of incident/change 
priority and urgency strings for the Mobility Client.
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Unload file
Introduced in  
9.3x patch

Used for 
apps version
(s) Description

QCCR1E78794_
SM930P6_SM930.unl

9.31 9.30 Removes incident.assignee when a Web Service call specifies the 
assignee as 'NULL' via the Mobility Client.

QCCR1E76796_
SM930P6_SM930.unl

9.31 9.30 Provides the ability to turn on debugging dynamically for user sessions or 
schedulers.

Note: This unload requires the SM9.31 server.

QCCR1E71099_
SM930P5_SM711.unl

9.30p5 7.11 Displays Value Lists instead of the data directly retrieved from the 
database in a QBE list when adding a field by using Modify Columns.

Associated server fix: QCCR1E71099

QCCR1E71099_
SM930P5_SM920.unl

9.30p5 9.20 Displays Value Lists instead of the data directly retrieved from the 
database in a QBE list when adding a field by using Modify Columns.

Associated server fix: QCCR1E71099 

QCCR1E71099_
SM930P5_SM930.unl

9.30p5 9.30 Displays Value Lists instead of the data directly retrieved from the 
database in a QBE list when adding a field by using Modify Columns.

Associated server fix: QCCR1E71099 

QCCR1E71139_
SM930P5_SM930.unl

9.30p5 9.30 Works with server fix QCCR1E71139 to solve this issue: When Service 
Manager is configured to use LDAP as the authentication data source, the 
user is still forced to change the password if the user is expired in the local 
database.
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Unload file
Introduced in  
9.3x patch

Used for 
apps version
(s) Description

QCCR1E31941_
SM930P4_SM930.unl

9.30P4 9.30 Enables users to use a pre-configured decimal symbol when completing 
numeric fields. 

Note: This enhancement requires a 9.30p4 or later server; however if 
you are using RTE version 9.30 with applications version 7.11 or 
9.20, do not load this unload file; you can safely upgrade your server 
to 9.30p4 or later without applying this applications change.

Associated server fix: QCCR1E31941.

QCCR1E73452_
SM930P4.unl

9.30P4 7.11 - 9.30 Enables Mandanten restricting queries to be updated correctly after a 
profile is edited.

Associated server fix: QCCR1E71897

QCCR1E67072_
SM930P4_SM930.unl

9.30P3 7.11 and 9.20 Enables users to take advantage of the new KMStatusListener 
background process.

Note: This unload file is not needed for applications version 9.30 or 
later, which supports only the Solr Search Engine.

Associated server fix: QCCR1E67071

QCCR1E70163_
SM930P4_SM711.unl

9.30P3 7.11 Fixes the issue that the KMUpdate process terminates abnormally.

Associated server fix: QCCR1E69687

QCCR1E70163_
SM930P4_SM920.unl

9.30P3 9.20 Fixes the issue that the KMUpdate process terminates abnormally.

Associated server fix: QCCR1E69687
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Unload file
Introduced in  
9.3x patch

Used for 
apps version
(s) Description

QCCR1E70163_
SM930P4_SM930.unl

9.30P3 9.30 Fixes the issue that the KMUpdate process terminates abnormally.

Associated server fix: QCCR1E69687

QCCR1E67647_
SM930P3.unl

9.30P3 7.11 - 9.30 Updates the exception message that occurs in the request response 
when closing an interaction by calling CloseInteraction from a web 
service without specifying the localSolution field in the request.

Associated server fix: QCCR1E54192

QCCR1E67610_
SM930P2.unl

9.30P2 7.11 - 9.30 Enables you to block potentially dangerous attachments.

Associated server fix: QCCR1E64290

Tip: If your application version is 7.11 ap3, 9.21 ap3, 9.30 ap3, 9.31 or later, you are recommended to use Unload Manager to load an 
unload file, because Unload Manager can help you create a backup of your old data and reconcile conflicts during the installation of the 
unload; if your application version is other than any of these, Unload Manager is not available and you can use Database Manager 
instead. 

To load an unload file using Unload Manager:

 1. Go to System Administration > Ongoing Maintenance > Unload Manager.

 2. Double-click Apply Unload. A wizard opens.

 3. Select the unload file you want to apply, also specify a backup file, and then click Next. Details of the unload file appear.

 4. Double-click a conflicting object in the table to open the merge tool:
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 a. Merge the object, and then select the Reconciled check box.

 b. Click Save to go back to the wizard.

 5. Click Next after all the conflicting objects are reconciled.

 6. Click Yes on the confirmation window to apply the unload.

 7. Click Finish. 

Now, the unload has been applied and at the same time your old data backed up.

To load an unload file using Database Manager:

 1. Make sure the Windows client is configured for server-side load/unload.
 a. From the Windows client, go to Window > Preferences > HP Service Manager.

 b. Unselect Client Side Load/Unload if is flagged.

 c. Restart the Windows client.

 2. Open Tailoring > Database Manager.

 3. Right-click the form or open the More Actions menu and select Import/Load.

 4. Browse to the unload file, and view the contents of an unload file before importing it by clicking List Contents.

 5. Make a backup copy of all files to be modified by this unload. For detailed steps, see "Backup and Backout Instructions" on page 27.

 6. Fill in the following fields.

Field Description

File Name Type the name and path of the file to load.
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Field Description

Import Descriptor Since unload files do not require an Import Descriptor record, leave this field 
blank.

File Type Select the source operating system of the unload file.

Messages Option —  

All Messages Select this option to see all messages that Service Manager generates 
loading the file.

Messages Option —  

Totals Only Select this option to see only the total number of files Service Manager loads.

Messages Option — 
None

Select this option to hide all messages that Service Manager generates when 
loading the file.

5 Click Load FG.

Mobile Application Update Installation
This release does not contain any mobile application update. The latest Mobile Application package has been shipped with the SM9.31p1 
release. 

You can download this package from http://support.openview.hp.com/selfsolve/document/KM00279017

For installation instructions, see the Service Manager 9.31p1 Release Notes.

Service Request Catalog (SRC) Installation
This release does not contain any SRC update. The latest SRC package has been shipped with the SM9.31 release. 

You can download this package from http://support.openview.hp.com/selfsolve/document/KM00207921
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To install SRC 1.4, extract the serviceRequestCatalog_SRC1.40.zip file, and then follow the instructions in the Service Request Catalog 
1.4 Interactive Installation Guide, which you can download from: http://support.openview.hp.com/selfsolve/document/KM00208652

ODBC Driver Update Installation
This release does not contain any ODBC Driver update. The latest ODBC Driver package  has been shipped with the SM9.30p4, SM9.30p5, 
and SM9.31 releases.

You can download the package from:

 http://support.openview.hp.com/selfsolve/document/KM00207925

The ODBC Driver package contains the following updated files:

 l Scodbc32.dll

 l sci18n.dll

 l sccl32.dll

To install the ODBC Driver update:

 1. Extract the files to your ODBC Driver installation folder, for example: C:\Program Files\Peregrine Systems\ServiceCenter 6.2\ODBC 
Driver.

 2. When prompted, replace the three old DLL files with the new ones.

Knowledge Management Update Installation
This release does not contain any KM update. The latest KM package has been shipped with the SM9.31p2 release, which you can download 
from: 

http://support.openview.hp.com/selfsolve/document/KM00405706

For instructions on installing the latest KM package, see the Service Manager 9.31p2 Release Notes.
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Note: The SM9.31p3 server patch includes an updated search engine schema file. For more information, see "Server's KM Search 
Engine Schema File Updated " on page 8.

Online Help Installation
This release does not contain an updated the version of the online help. The latest online help package has been shipped with the SM9.31 
release. 

You can download this package from http://support.openview.hp.com/selfsolve/document/KM00208653

To install the online help,  follow the instructions in the Service Manager 9.30 Interactive Installation Guide, which you can download from: 
http://support.openview.hp.com/selfsolve/document/KM1195794
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Service Manager Support Matrix
The Support Matrix lists supported versions of operating systems, browsers, HP Software 
products, and other compatibility and support information.

Note: Most of the support areas require that you register as an HP Passport user and sign in. Many 
also require an active support contract. To find more information about support access levels, go to      
Access levels.

To register for an HP Passport ID, go to      HP Passport Registration.

To access the Support Matrix:

 1. Use a browser to navigate to the Software Support Online (SSO) web page:

http://support.openview.hp.com/sc/support_matrices.jsp

 2. Log on with your Customer ID and password or your HP Passport sign-in.

 3. Navigate to the applicable information. 
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